
Formation QGIS 3.x

Journée 3 – 26 novembre 



Journée 3
• Symbologie

• Géocodage

• Statistiques & Diagrammes
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Représenter
Style 

Symbole
Gérer

Ressources

• Représenter la donnée
• Style
• Symboles

– Couche de symboles
– Ponctuels
– Linéaires
– Surfaces
– Polygone inversé

• Gérer
• Ressources
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Représenter la donnée

Nombreuses manières de représenter la donnée, et 
qui peuvent se combiner

• En fonction de l’échelle → lisibilité est recherchée

• En fonction d’attributs → cartes thématiques

• En fonction du public visé → grand public <> spécialistes

• En fonction du média de communication → écrans, sortie 
papier (A4 → A0), fichier PDF
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Style

STYLE : plus haut niveau d’organisation de la 
représentation → éléments suivants :

• Symboles → représentation graphique

• Etiquettes → texte graphique sur la carte

• Info-bulles → au survol de la souris

• Présentation des attributs

• Etc.
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Style

Outils pour sauver, exporter, importer les 
styles associés aux couches

• Donner des noms significatifs aux styles, 
plus facile pour les gérer

• Fichiers *.qml

• Entrepôt de styles → localisation à définir 
via menu Préférences → Options → Sources 
de données → « Localized Data Path » 
(redémarrer QGIS)
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• Options de création – personnalisation - d’un 
symbole sont … très nombreuses

• Impossible d’aborder toutes les combinaisons

• Usage et la créativité personnelle → définir un 
catalogue efficace de symboles …

• S’inspirer des éditeurs cartographiques 
professionnels : les légendes des cartes IGN, Michelin 
… sont généralement très efficaces.

Editeur de Symboles



Editeur de Symboles
• Très puissant et offre différents niveaux de 

représentation des entités (objets).

• Un symbole peut être composé d’une ou de 
plusieurs représentations (empilement de couches 
de représentation)

• L’éditeur de symboles propose un maximum 
d’interfaces communes pour tous les types (Point, 
Ligne, Surface) mais d’autres sont spécifiques à la 
nature géométrique de l’objet.

• Modes simple et avancé de représentation sont 
proposés
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Editeur de Symboles

• Le niveau supérieur de définition du symbole 
dépend de la géométrie de la couche de données

• Marqueur (données Ponctuelles), Ligne (données 
Linéaires) ou Remplissage (données Surfaciques)

• Ensuite, chaque symbole peut incorporer un ou 
plusieurs symboles (y compris, de tout autre type) 
: c'est la couche de symboles (ou symbole à 
représentations multiples).
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Symboles

Deux accès (pour une couche vectorielle)

• Propriétés de la couche → Symbologie

• Par un double-clic bouton gauche de la souris, sur la 
représentation de la couche
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Symboles
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1 - Mode de rendu du 
symbole
2 - Personnalisation d’un 
symbole
3 - Unité et Opacité de la 
représentation (inverse 
transparence)
4 - Palette de couleurs
5 - Catalogue de symboles 
prédéfinis
6 - Accès au gestionnaire de 
styles
7 - Représentation des 
symboles d’un groupe
8 - Rendu de la couche
9 - Gestion du style courant
10 - Sauver le symbole 
courant
11 - Edition avancée – non 
documenté



Symboles
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• Un symbole peut être composé de plusieurs couches de 
symboles

• Un symbole est constitué d’au moins une couche de symbole

• L’arborescence des symboles montre la superposition (et 
l’ordre d’empilement) de ces couches de symboles qui sont 
ensuite combinées pour former un nouveau symbole global.

 Rendu : symbole unique

 Type : ligne

 Composé de 3 couches 



Modes de rendu du symbole
Le mode de rendu donne accès aux différents modes 
d’affichage des entités, le plus simple étant le « Symbole 
unique ». 
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Pas de symbologie

Unique : symbole pour rendre de manière identique toutes les entités de la couche

Catégorisé : symboles dont l’aspect reflète des valeurs discrètes (chaine de caractères)

Gradué : symboles dont l’aspect reflète des classes de valeurs (dates, valeurs numériques)

Ensemble de règles : symboles associant des combinaisons d’attributs

Entités fusionnées : symboles lignes/surfaces assurant une représentation continue 

Polygones inversés : symbole à appliquer à l’extérieur des polygones de la couche.

2,5 D : pseudo 3D

Symboles intégrés : afficher la symbologie “native” d’une source de données KML ou TAB



Unités du symbole
• Unités : unités d’affichage des symboles : mm (par 

défaut), points, pixels, mètres à l’échelle, unités de 
cartes pouces. 

• Millimètres et Unités de cartes sont les plus utiles.
– Millimètre : La valeur millimétrique indiquée reste 

constante, quelle que soit l'échelle de la zone 
d'affichage cartographique de QGIS

– Unités de carte : La taille du symbole varie en fonction 
de l’échelle : il paraît de moins en moins large plus 
l'échelle devient petite. L’unité est le « mètre terrain » si 
l’unité de mesures du terrain est le mètre (Propriétés du 
projet → Onglet Général → Mesures).
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Palette de couleurs

Outil (« widget ») commun : palette de couleurs

Formation QGIS – © JM Michalowski  - IFAPME 2024 15

menu Préférences → Options → Couleurs → définir des palettes personnelles



Catalogue de symboles QGIS
• QGIS propose un catalogue de symboles prédéfinis pour 

tous les types de géométrie, ainsi que des palettes de 
couleur.

• Ce catalogue peut être consulté depuis le Gestionnaire de 
Style
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Rendu de la couche
• Opacité : définir le niveau d’opacité de toute la couche de 

symboles. 
– entièrement opaque : valeur 100

– entièrement transparente : valeur zéro.

• Mode de fusion : définir la manière dont une couche va 
s'intégrer dans celle située en-dessous pour le mode de 
fusion entre couche, ou entre objets de la couche pour le 
mode de fusion entre objets.
– Fusionner, assombrir, éclaircir …

– Fonctionnalité développée pour les graphistes

– Cartographie : à utiliser avec modération (impressions !!)

Formation QGIS – © JM Michalowski  - IFAPME 2024 17



Paramètres généraux POINTS
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Type de symbole : voir catalogue
Taille: une valeur définie (+ choix de 
l’unité)
Couleur de remplissage : palette
Opacité : de 100 % à 0 %
Rotation : à définir si nécessaire
Choix du symbole : catalogue de 
symboles par défaut (cas du type « 
Symbole simple »)

Quand le symbole ne 
comporte qu’une couche, ce 
sont les paramètres généraux 
qui s’appliquent



Paramètres généraux LIGNES
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Type de symbole : voir catalogue
Largeur : une valeur définie (+ choix de 
l’unité)
Couleur de remplissage : palette
Opacité : de 100 % à 0 %
Choix du symbole : catalogue de 
symboles par défaut (cas du type « 
Symbole simple »)

Quand le symbole ne 
comporte qu’une couche, ce 
sont les paramètres généraux 
qui s’appliquent



Paramètres généraux SURFACES
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Type de symbole : voir catalogue
Couleur de remplissage : palette
Opacité : de 100 % à 0 %
Choix du symbole : catalogue de 
symboles par défaut (cas du type « 
Symbole simple »)

Quand le symbole ne 
comporte qu’une couche, ce 
sont les paramètres généraux 
qui s’appliquent



Symbole SVG
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Les images SVG (Scalable Vector 
Graphics) peuvent être agrandies 
à l’infini sans perte de qualité.

Bibliothèque personnelle de SVG



• Symboles vectoriel SVG

– Votre moteur de recherche favori

– Viewer SVG : 

• Microsoft Hegde (IE)

• XnView (https://www.xnview.com/fr/ ) : visionneuse 
multimédia efficace, un explorateur et convertisseur. 

– Bibliothèques

• https://www.flaticon.com/ (3.500.000 icones SVG)

• Bibliothèque SVG du projet OSM
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Symbole SVG

https://www.xnview.com/fr/
https://www.flaticon.com/
https://github.com/openstreetmap/map-icons/tree/master


Symbole SVG
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Répertoire personnalisé

Répertoire personnalisé

Accès à la bibliothèque SVG : 
menu Préférences → Options → Système → SVG Paths



Ordre de tracé des couches de symboles

• L’ordre de tracé des couches de symboles est le suivant : la 
première couche est dessinée au-dessus, tandis que la 
dernière est tracée tout en-dessous.

• Des boutons permettent la navigation parmi les couches. 

• Le verrouillage de la couleur d’une couche empêche la 
modification de sa couleur lors d’un changement de la 
couleur du niveau supérieur du symbole.
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Ordre de tracé des couches de symbole

• La largeur du symbole est définie par la largeur (du niveau 
supérieur) du symbole.

• Mais si la largeur d’une couche est supérieure à celle-ci, la 
largeur du niveau supérieur s’adapte pour la prendre en 
compte.

• Les largeurs des autres couches sont ensuite recalculées en 
proportion du changement de la largeur du (niveau 
supérieur) du symbole.
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Gestionnaire de styles

Organisation des Styles
1. Créer, modifier, et supprimer des styles pour vos couches 

de données.

2. Organiser vos styles en différentes catégories et sous-
catégories pour une meilleure gestion.

Création et Modification des Symboles
1. Créer de nouveaux symboles ou modifier les symboles 

existants

2. Large variété d'options pour personnaliser les symboles
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Gestionnaire de styles
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Gestionnaire de styles

Deux options principales pour gérer la localisation des styles
– Défaut : accessibles dans tous vos projets QGIS (cohérence styles 

à travers tous les projets)

– Projet : spécifiques au projet sur lequel vous travaillez.

Avantages et Inconvénients
– Défaut:

• Avantage : Réutilisation facile des styles.

• Inconvénient : Peut devenir encombrant si trop de styles sont enregistrés.

– Projet:
• Avantage : Organisation claire et spécifique au projet.

• Inconvénient : Les styles doivent être recréés pour chaque nouveau projet.
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Gestionnaire de styles

Marque-pages :
• Enregistrement et accès rapide aux styles fréquemment utilisés.

• Facilite la standardisation et améliore la gestion des symboles.

Toutes : affichage de toutes les étiquettes (Défaut + Projet)

Etiquettes : liste des mots-clés 

Groupes intelligents : 
• Organisation automatique des symboles en fonction de critères définis.

• Simplifie la gestion des symboles (?).

Ajouter un mot-clé Un style peut être balisé avec plusieurs mots-clés différents (,)

Ajouter un groupe intelligent → définir les critères de tri

Modifier le groupe : associer un mot-clé à un groupe de symboles

Importer / exporter des styles depuis/vers fichier XML
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Exercices

1 : Symbologie



EXERCICE 1

Le Gestionnaire de Styles
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Gestionnaire de styles
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Nouveau projet

Si des symboles sont présents, 
les sélectionner tous puis les effacer



Gestionnaire de styles
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Gestionnaire de styles
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Gestionnaire de styles
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Gestionnaire de styles
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EXERCICE 2

Polygones : Rendu catégorie, centroïdes SVG et fond 
raster
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Polygones : rendu catégorisé

Ouvrir le projet D:/Cartographie/Data/Jour/Jour3-01.qgz

Couche « Corine Land Cover »

1. Couche > Propriétés > Symbologie > [Style]

2. Charger le style « CLC_2018_FR_VDL_ORI.qml »
sous D:\Cartographie\Symbologie\Styles 
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Polygones : rendu catégorisé
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Polygones : rendu catégorisé
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Symbole SVG
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Répertoire personnalisé

Répertoire personnalisé

Accès à la bibliothèque SVG : 
menu Préférences → Options → Système → SVG Paths



Polygones : rendu catégorisé

1. Modifier le symbole « Zones industrielles et commerciales »

2. Remplissage de fond + remplissage centroïde avec SVG
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Polygones : rendu catégorisé

3. Ajouter « Remplissage de centroïde » puis choisir le SVG

4. Paramétrer l’affichage du SVG
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D:/Cartographie/Symbologie/SVG/EquipementsPublics/00_industrie.svg



Polygones : rendu catégorisé

5. Changer la couleur du symbole de remplissage

6. Sauver le symbole
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Polygones : rendu catégorisé
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Polygones : rendu catégorisé

1. Modifier le symbole « Forêts de feuillus »

2. Remplissage de fond avec une image PNG
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D:/Cartographie/Symbologie/Raster/Landuse-forest.png



Polygones : rendu catégorisé
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EXERCICE 3

Polygones : Rendu catégorisé
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Polygones : rendu catégorisé

• Couche Espaces Verts Liège
– Accéder au symbole et le modifier pour arriver à 

– [Appliquer]  > [OK]
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Polygones : rendu catégorisé

• Couche Espaces Verts Liège
– Revenir au symbole pour définir un rendu catégorisé

– L’attribut LANDUSE (OSM) de la couche Espaces Verts permet de 
décrire le type d’espace vert. 
• Cemetery [cimetière]

• Park [parc]

• Farmyard [(cour de) ferme]

• Greenhouse_horticulture [horticulture]

• Farmland [agriculture]

• Grassland  [prairie]

– Type de rendu : choisir Catégorisé
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Polygones : rendu catégorisé

• Valeur : Landuse

• Symbole : garder symbole courant

• Palette de couleurs : Greens

• Bouton [Classer]

• Editer la légende (double clic) et décrire les différents types

• Supprimer la 7e classe  et [Appliquer]

Formation QGIS – © JM Michalowski  - IFAPME 2024 51



Polygones : rendu catégorisé
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Décocher une des classes et constater dans la carte que les 
objets qui correspondent à cette classe, sont masqués



EXERCICE 4

Polygones : Rendu gradué, function round($area,1)
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Polygones : rendu gradué

• Couche Espaces Verts
– Revenir au symbole pour définir un rendu gradué

– Type de rendu : choisir Gradué

– Valeur : clic sur         > Ouvre le calculateur d’expressions

– Géométrie
• Attributs géométriques des

entités

• $area : superficie

• Valider [OK]
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Polygones : rendu gradué

Les options les plus intéressantes
• Les modes de classement (les plus utiles) et l’histogramme 

correspondant
– Intervalle égal : pour toutes les classes, la différence entre la valeur 

minimale et la maximale est constante
– Jolies ruptures : pour toutes les classes, la différence entre la valeur 

minimale et la maximale est constante et les limites de classes sont 
arrondies (aux dizaines par exemple)

– Nombre égal : les intervalles de classes sont calculés afin de répartir les 
objets de façon équitable entre les différentes classes.

• Le nombre de classes pour caractériser la plage de valeurs
• La légende : 

– Précision : précision des valeurs hautes et basses des textes 
d’étiquettes
• Un nombre positif représente les décimales
• Un nombre négatif arrondit aux puissances de dix

– Couper : suppression des « zéros » inutiles
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Polygones : rendu gradué
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Légende : 
• Précision 1 décimale
• Couper les zéros
Classer ensuite



Polygones : rendu gradué
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Polygones : rendu gradué
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Polygones : rendu gradué
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Rendu Gradué par Jolies Ruptures



Polygones : rendu gradué
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Rendu Gradué par Nombre égal – 3 classes



EXERCICE 5

Représentation lignes : épaisseur Style <> Symbole
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Représentation de lignes

1. Ajouter un champ pour calculer la longueur de la ligne

2. Appliquer une symbologie « Gradué » sur la longueur

3. Modifier les symboles de ligne proposés par défaut

4. Sauver le style
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Représentation de lignes

Couche «  Haie remarquables » : ajouter un champ

1. Couche > Propriétés > Champs

2. Passer en mode Edition 

3. Ajouter un champ « Longueur » de type Nombre décimal 

4. OK pour quitter le panneau

5. Sauver les modifications

Formation QGIS – © JM Michalowski  - IFAPME 2024 63



Représentation de lignes

Couche «  Haie remarquables » : calculer la longueur

1. Couche > Propriétés > Champs

2. Activer la calculatrice de champs → constructeur de requêtes

3. Mise à jour d’un
champ existant

4. Champ « Longueur »

5. Groupe « Géométrie »

6. $length

7. round($length,1) 
→ arrondir 1 décimale

8. Sauver 
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Représentation de lignes

Couche «  Haie remarquables »

1. Couche > Propriétés > Symbologie > Gradué (Classes)

Formation QGIS – © JM Michalowski  - IFAPME 2024 65

Palette « Greens »



Représentation de lignes
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Décocher Espaces Verts
Zoomer 45.000e



Représentation de lignes

Editer les paramètres de la dernière classe

1. Ajouter une couche de symbole de type Ligne 
simple, de couleur rouge et d’épaisseur 0,2
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Représentation de lignes

2. Augmenter l’épaisseur du symbole à 1,0

3. Constater que l’épaisseur de la ligne rouge s’adapte et 
passe à 0,33
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EXERCICE 6

Représentation lignes : symbole multi-couches
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Représentation de lignes
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Groupe « Mobilité » - Couche « RAVEL »

• Symbologie > Rendu Catégorisé > Valeur : REVETEMENT



Représentation de lignes
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Représentation de lignes
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Représentation de lignes
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Représentation de lignes
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EXERCICE 7

Représentation par Ensemble de règles
Représentation par Entités fusionnées
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Représentation par ensemble de règles
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Groupe « Mobilité » - Couche « Voirie Liège »

Afficher les signets spatiaux [Ctrl+-Maj+B]



Représentation par ensemble de règles
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Groupe « Mobilité » - Couche « Voirie Liège »

Couche > propriétés > Symbologie

Style > Charger le style …



Représentation par ensemble de règles
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D:\Cartographie\Symbologie\Styles\OSM Roads FR.qml



Représentation par ensemble de règles
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Représentation par ensemble de règles
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Représentation par Entités fusionnées
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• Permet de simuler une fusion des différents objets d’une couche, pour un rendu 
plus esthétique.

• Ainsi la fusion peut regrouper visuellement tous les objets grâce un même 
symbole.

• Elle peut aussi assembler les objets avec des caractéristiques semblables (via une 
catégorisation/graduation).

1. Ces fusions sont un artifice visuel, les objets restent indépendants les uns des autres.
2. S’il y a beaucoup d’entités, cette opération réalisée en temps réel peut être longue.



Représentation par Entités fusionnées
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Représentation par Entités fusionnées

Formation QGIS – © JM Michalowski  - IFAPME 2024 83

Afficher les signets spatiaux [Ctrl+-Maj+B]

Avenue des Tilleuls



Symbologie OSM

https://github.com/openstreetmap/map-
icons/tree/master 

https://wiki.openstreetmap.org/wiki/FR:%C3%
89l%C3%A9ments_cartographiques 

https://github.com/gravitystorm/openstreetma
p-carto/tree/master/symbols 
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https://github.com/openstreetmap/map-icons/tree/master
https://github.com/openstreetmap/map-icons/tree/master
https://wiki.openstreetmap.org/wiki/FR:%C3%89l%C3%A9ments_cartographiques
https://wiki.openstreetmap.org/wiki/FR:%C3%89l%C3%A9ments_cartographiques
https://github.com/gravitystorm/openstreetmap-carto/tree/master/symbols
https://github.com/gravitystorm/openstreetmap-carto/tree/master/symbols


EXERCICE 8

Configurer des symboles ponctuels SVG
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Symbole SVG

Couche « Arrêts TEC Liège » > Propriétés > Symbologie 
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Symbole SVG
> Navigateurs SVG : choix du symbole
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Symbole SVG
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Couche Arrêts TEC >
Echelle et visibilité de la couche

88



EXERCICE 9

Représentation par Groupement de points
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Groupement / Grappe de points
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Lorsque vous devez localiser un grand 
volume de points sur une carte, 
le cluster devient indispensable pour  
garantir une bonne lecture de vos 
informations.

Plus vous zoomez, plus celles-ci seront 
détaillées. De plus, les clusters permettent 
de dégager rapidement des grandes 
tendances, puisque leur taille peut varier 
selon les données



Groupement / Grappe de points
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• Couche « Environnement / Obstacles Verticaux »  > Zoom sur la couche
• Propriétés > Symbologie



Groupement / Grappe de points
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Cluster – distance 5 Cluster – distance 10



EXERCICE 10

Représentation par Polygones inversés
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Polygone inversé

L'affichage par polygone inversé dans QGIS est une technique 
de symbologie qui permet de dessiner le polygone en inversant 
son apparence. Cela signifie que le style ou l'effet appliqué est 
affiché à l'extérieur du polygone, plutôt qu'à l'intérieur. Cela 
peut être utile pour créer des effets visuels intéressants, 
comme des ombres portées ou des masques.
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Bien gérer l’ordre des couches pour que le masque soit efficace



Polygone inversé
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Polygone inversé

Couche « Limites communales »

1. Couche > Propriétés > Symbologie > Polygones inversés
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Polygone inversé
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Définir la règle → critère d’exclusion



Polygone inversé
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Définir la symbologie du polygone masquant

Adapter l’ordre des couches : la couche 
masquante se place tout au-dessus 



Polygone inversé
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Rendre la couche « privée » [propriétés projet]



Polygone inversé
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Résultat final



Géocodage

• Définition

• Outils

• Geocode by Awesome 
Table 
– Qualité du fichier

– Champs « adresse postale »

– Géocodage

• Créer une couche de points 
à partir du géocodage
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Géocodage

1. Le géocodage consiste à affecter des coordonnées 
géographiques (longitude/latitude) à une adresse 
postale.

2. Ce procédé nécessite la mise en place de traitement 
automatisé de manière ponctuelle ou sur des fichiers 
d’adresses (individus, entreprises, points d’intérêt, etc.).

3. Les coordonnées géographiques permettent de situer 
chaque adresse sur une carte numérique via un SIG.
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Géocodage

103Formation QGIS – © JM Michalowski  - IFAPME 2024

Vérifier la qualité des données à importer

• Supprimer les doublons, triplets …

• Supprimer les lignes sans adresse postale définie ou les 
corriger

• Eviter les noms de commune d’avant fusion (1977 !)

Adresse inconnue : ?
Nom de commune ancien

Commentaire sur adresse

Deux adresses postales dans une case



Géocodage

104Formation QGIS – © JM Michalowski  - IFAPME 2024

Convertir une adresse postale en Latitude / Longitude (WGS 84)
• Compte GMAIL (! Si plusieurs comptes GMAIL)

• Ouvrir une « Google Sheet », ajouter le module « Geocode by 
Awesome »

• Importer le tableur Excel  à convertir dans cette Google Sheet



Géocodage
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Fichier sous ../data/Jour3/DataExternes



Géocodage
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Géocodage
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Géocodage
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Géocodage
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Maximum de requêtes par jour !!
• 2500 (Wikipedia) → +/- 800
• Couper le fichier en morceaux
• Exécuter sur plusieurs jours ou

sur plusieurs adresses @gmail
• Ou acheter une licence …



Géocodage
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Géocodage
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La Place 10

Google Maps



Géocodage
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Géocodage
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[Create map]

[Open map]



Géocodage
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Suppression de la ligne 2 → création de la carte 

Téléchargement au format Excel



Géocodage
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Ouvrir le projet ../data/Jour3/Jour3-02.qgz

Ajouter une feuille de calcul



Géocodage
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• Se placer dans le groupe « Data »

• Ajouter une feuille de calcul



Géocodage
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Géocodage
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Statistiques &
Diagrammes

• Les outils statistiques de 
base

• Un plug-in : Group Stats

• Diagrammes
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Outils de base

• Récupérer les valeurs d’attributs géométriques
– Superficie : $area 

– Longueur : $length

– Périmètre : $perimeter 

– Coordonnée X : x(@geometry)
• x(transform($geometry, 'EPSG:source', 'EPSG:cible'))

• x(transform($geometry, 'EPSG:3812', 'EPSG:313170’)) : L2008 → L72

– Coordonnée Y : y(@geometry)
• y(transform($geometry, 'EPSG: source', 'EPSG: cible'))

– Coordonnée Z : Séance 4

• Arrondir les valeurs (2 décimales)

 round($Fonction,2)
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Outils de base
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Statistique Valeur
Compte 30
Somme 7136,7
Moyenne 237,89
Médiane 153,45
St dev (pop) 231,576
Écart-type (exemple) 235,535
Minimum 25,7
Maximum 861,8
Plage 836,1
Minorité 25,7
Majorité 25,7
Variété 30
Q1 107,8
Q3 300,6
IQR 192,8
Valeurs (null) manquantes  0

Résumé statistique



Plug-in Group Stats

Group Stats est un plugin pour QGIS qui permet de calculer 
facilement des statistiques pour les groupes d'entités dans une 
couche vectorielle → « Tableau croisé dynamique Excel »

• menu > Extensions > Toutes

• Rechercher : mot-clé « Group » 

• Installer « Group Stats » 
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Plug-in Group Stats

Analyse à réaliser : Comment calculer la superficie totale de 
chaque classe Corine Land Cover (CLC) par Quartier de Liège ? 

1. Préparation des données : Intersection Quartiers X CLC

2. Analyse via Group Stats

3. Export des données
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Plug-in Group Stats

Intersection des couches 

• menu > Vecteur > Outils de géotraitement > Intersection
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1. Couche CLC : style > Copier le style > Symbologie
2. Couche Intersection : Style > Coller > Symbologie



Plug-in Group Stats
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Recalculer les superficies
après intersection

Couche « Intersection »



Plug-in Group Stats
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Zone d’affichage 
des résultats

Liste des champs

Paramètres de 
l’analyse

Constructeur 
de requetés

Paramètres : 
Colonnes : classes de couverture (Code_18)
Lignes : les noms des Quartiers 
Valeurs : somme des superficies



Plug-in Group Stats
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menu Données 

• Copier vers presse-papiers
• Exporter en CSV

La zone d’affichage
ne peut pas être vidée



Plug-in Group Stats
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Ouverture du CSV avec LibreOffice



Plug-in Group Stats
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Ouverture du CSV avec Excel



Diagrammes
Les diagrammes associés à une couche permettent de visualiser 
des informations attributaires de manière graphique et 
intuitive. Différents types de diagrammes sont disponibles :

• Diagramme en secteurs (« Pie-chart »)
– Affichent les proportions relatives des différentes valeurs d'un attribut.

• Diagramme de texte
– Un cercle divisé horizontalement et contenant des valeurs statistiques 

• Histogramme
– Barres de couleurs variables pour chaque attribut, alignées les unes à côté des autres.

• Barres empilées
– Empile verticalement des barres de couleurs différentes pour chaque attribut.
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Diagrammes

Diagramme en secteurs : afficher les proportions de population 
Hommes et Femmes pour les différents quartiers de Liège.

• Données nécessaires (sur la couche « Quartiers »)
1. Population Hommes

2. Population Femmes

3. (Population totale)
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Couche « Quartiers » > Propriétés > Diagramme



Diagrammes
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Ajouter les attributs Population Hommes et Population Femmes

Définir les couleurs pour les 2 valeurs d’attribut



Diagrammes
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Définir le rendu d’affichage



Diagrammes
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Définir les dimensions d’affichage



Diagrammes
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Taille : 10 Taille : 15



Diagrammes
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Définir la position du diagramme



Diagrammes

137Formation QGIS – © JM Michalowski  - IFAPME 2024

Définir la légende

Symbole sous D:\Cartographie\Symbologie\
Symboles\DisqueLegendeDiagramme.jpg



Diagrammes
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Résultat dans la fenêtre des couches



Etiquettes élaborées
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Paramètres de base - Texte

Couche « Quartiers » > Propriétés > Etiquette



Etiquettes élaborées
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Paramètres de base – Arrière-plan



Etiquettes élaborées
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Paramètres de base – Position

Valeur < 0 pour décalage 



Etiquettes élaborées
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Paramètres de base – Valeur de l’étiquette

Constructeur de requêtes – insertion d’une formule



Etiquettes élaborées
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round(( "PopFem" /  "POP2015" ) *100,1) || ' %’ ||  '\n'  
||round(( "PopHommes"/"POP2015" ) *100,1) || ' %' 

Etiquette de base

|| : opérateur de concaténation
\n : saut de ligne



Etiquettes élaborées
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'F :’|| round(( "PopFem" /  "POP2015" ) *100,0) || ' %’ ||  
'\n'  ||'H : '||round(( "PopHommes"/"POP2015" ) *100,0) 
|| ' %' 

Etiquette améliorée

|| : opérateur de concaténation
\n : saut de ligne



Etiquettes élaborées
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'<span style="color: rgb(255, 0, 0);"> &#9792; : '||round(( 
"PopFem" /  "POP2015" ) *100,0) ||' %</span><br><span 
style="color: rgb(0, 0, 255);">&#9794; : '||round(( 
"PopHommes"/"POP2015" ) *100,0) || ' %</span>'

Etiquette avec code HTML

<span> : appliquer un style pour une mise
en forme du texte
<br> : saut à la ligne (HTML) → <hr> si <br> ne 
fonctionne pas
&#9792; : symbole femme HTML ( )
&#9794; : symbole homme HTML ( )



Editeur HTML léger

146Formation QGIS – © JM Michalowski  - IFAPME 2024

https://nvu.en.softonic.com/ 

https://nvu.en.softonic.com/


Infobulle élaborée

Les infobulles dans QGIS sont un outil utile pour afficher des 
informations supplémentaires lorsqu'on passe la souris sur un 
élément de la carte. Elles permettent de montrer des attributs 
spécifiques d'un objet sans avoir à ouvrir une nouvelle fenêtre 
ou à modifier la carte elle-même.
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Couche « Quartiers » > Propriétés > Infobulle



Infobulle élaborée
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Infobulle élaborée
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<table style="text-align: left; height: 32px;"
 border="1" cellpadding="2" cellspacing="2">
  <tbody>
    <tr>
      <td><span style="font-style: italic;">Quartier</span>
: <span style="font-weight: bold; color: rgb(51, 102, 
255);">[%Nom%]</span></td>
    </tr>
  </tbody>
</table>

Code HTML construit via NVU



Infobulle élaborée
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